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 Revised August 2019  

 

A quick introduction to STATA:  
(by E. Bernhardsen, with additions by H. Goldstein)  

 

 

 

1. How to access STATA from the pc’s at the computer lab and elsewhere  
 
Log in at https://kiosk.uio.no/ and find STATA (SE or MP) under Analyse.  

 

 

2. The windows:  
 
STATA has separate windows for typing in commands and for viewing results. In the review window you can 

view (and activate by clicking on a command) the command lines you have previously written. In the 

variables window all variables and labels are listed.  

 

When opening Stata you get (version 15.1) 

 

 

Stata is a command-driven system. Commands are written in the command window. E.g., to calculate 2+3, 

you need the command display (or di for short). Try the command  

display 2+3 (or short: di 2+3) and enter.  

https://kiosk.uio.no/
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You will see a copy of the command in the review window. If you want to calculate 2+5 instead, as a shortcut 

just click the command in the review window - producing a copy in the command window – and edit the 

command to di 2+5 there.  

 

The working directory. The first thing you need to do is to establish your working directory (i.e., where your 

output will be saved and where you will keep your Stata data files) in your M:\-area. The current working area 

– where you don’t have access - is written at the lower left corner of the Stata window.  

 

It is a good idea to create (e.g., with “explorer”) a subdirectory in your M:\ to contain all relevant outputs 

from Stata. For example, if your name of the subdirectory you made is statadat, you can change your 

working directory to statadat by running the command, cd M:\statadat . Alternatively, you may 

achieve the same by clicking on Change working directory on the file menu. Finally, check the 

lower left corner of the Stata window that you have gotten the right working directory. From now on all your 

Stata output will be put there. 

 

Appearance.  

If you prefer colours, right-click the window and go to preferences -> color scheme. Then, e.g., the option 

classic gives 

 

 

 

Exercise 1; Load the exercise data, stored in a file called auto.dta, which is included in STATA. I.e., write 

sysuse auto (or sysuse auto.dta) in the command window and press enter (more details below).  

 

You can obtain a description of the data set via the menu:  

File -> Example datasets -> Example datasets installed with Stata  
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and then click the describe link outside auto.dta.  

 

In any case you will see that the command line enters the review window and the results window (this 

illustrates how the menus can be used to learn the command lines. Learning the commands facilitates greater 

flexibility, quicker computing, and clearly a better understanding of how the program operates). For example, 

from the review window we see that the data description we obtained via the menus, we could have obtained 

directly by entering the command sysdescribe auto.dta. Clicking on that line reproduces the command in the 

command window. Pressing enter then runs the command again.  

 

Note also that now all the variables in the data set are listed in the variables window.  

 

To look at the data, click, e.g., the browse icon to get the browse window. In the browse window you cannot 

change anything (it is read-only). If you want to edit the data, click on the edit icon instead.  

 

 

3. More on how to load, save and use the built-in data set, auto.dta  
 
To obtain a list of all built-in data sets that follow with STATA, you can use the command sysuse dir.  

 

The command dir gives a listing of your own working directory (i.e., M:\statadat if that is the name).  

 

You can save a copy of the data set (or any other data set) in your own working directory by the command 

save, and later retrieve it by the command use. By save the data are stored in a binary file (with extension 

.dta) – in a special STATA format that is easy to read for STATA. For example, the command save auto, 

makes a copy of the data set, with name “auto.dta”, in your working directory. This is especially useful if you 

have made changes and additions to the data set during your STATA session. Then, next time you start 

STATA for a new session, after having changed the working directory, you can simply give the command use 

auto, and the data are reloaded into STATA as you left them last time.  

  

 

 

 

 

4. The spreadsheet:  
If you write edit or browse in the command box (or click the edit or browse icons), a spreadsheet window 

will pop up. If you used the browse command, you can only view and not edit the spreadsheet. With the edit 

command  you can also edit the spreadsheet. 
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Given that you are in the edit window, you can edit the name, the variable labels, or even the format of the 

variable, in the windows on the right. In the spreadsheet you have opened (the Edit window), click the 

variable “make” in the upper right window. Then you will see (in the lower right window) that the label is 

“Make and model” and the format is “%-18s” – which can be edited there. The s indicates that the variable 

“make” is a string variable (consists of letters, not numbers), and that it will be stored using (maximum) 18 

letters. The variable “price” has the different format “%8.0gc”. Here, the letter “c” indicates that a comma is 

used to separate at the thousands, while “g” indicates that the variable is stored as an integer. If we change the 

format to read “%8.1fc”, the variable is no longer stored as an integer, but as a number on the real line where 

one decimal place is shown. If we edit it to “%8.2fc”, two decimal places is shown etc. Writing only “%8.2f” 

will take away the comma separation at the thousands.  

 

A note on formats; number variables can indeed be stored as string variables. This will often be the case when 

the data that is loaded is not originally in STATA format. When such data is loaded, it is therefore good 

practice to check whether the number variables are stored correctly. Note that numbers stored as strings get 

the color red in the data window.  

 

In STATA you can refer to each variable by the variable name. You can also refer to the line number in the 

data matrix by using the reference “in” as in exercise 2.  

 

Exercise 2; Write the command list make in 2, and the command list weight in 1/7. What is returned in the 

results window?  
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5. The help facility:  
Suppose you want to use the generate command, and cannot quite remember how it is used. You can then 

type help generate in the command window. Then a new “viewer window” with the help appears. (The 

“viewer” is an attached program that is designed to read STATA output files. It can read other files as well.) 

This window can be printed by specification on the file menu. The view editor can also be used to view and 

print contents of the results window. See “using log files”, later in this document.  

 

 

 

The information you get from the help function is somewhat condense and sometimes hard to understand 

when you are a beginner. In Help -> PDF Documentation on the menu you will find complete documentation 

written in understandable terms with lots of examples and descriptions of methods used. Much can be learned 

about statistics/econometrics by reading in that documentation. There are also a lot of stuff about Stata on the 

web (can be accessed from the Stata –help menu) – examples, programs, data, etc.  
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6. The command syntax:  
 
The command syntax is almost always on the general form:  

 

[by varlist:] command [varlist] [if exp] [in range] [ ,options ]  

 

where:  

varlist refers to a list of variables, e.g., mpg weight length price.  

exp refers to a logical expression  

range refers to a range of line numbers  

,options will depend on the command in question. The options must be specified at the end of the 

command line, after a comma separator. NB: A comma in a command always means that what follows is a 

list of options to the command!  

 

The brackets indicate that the specification inside is optional. For example, the [by varlist:] formulation is 

optional. It specifies that the command is to be repeated for each variable in the variable list. Not all 

commands, however, can use this option.  

 

The command syntax is best illustrated by a few simple examples:  

 

EXAMPLE; In the tutorial dataset we may want to construct a new variable that equals mpg/weight. 

Writing help generate in the command window returns the following syntax from the results window.  

 

generate [type] newvar[:lblname] = exp [if exp] [in range]  

 

Here the command name (generate- or short: gen), the name of the new variable to be generated (newvar), 

and the function that describes how the new variable is to be constructed (=exp) has to be specified. The help 

text explains that [type] has to be specified only if the variable that you want to create is to become a string 

variable, or if it is important to specify the decimal precision of the new variable. If a string variable is to be 

generated type can be specified to str10 if the variable is to be stored with 10 letters. If a number variable that 

is generated has to have decimal precision type can be specified to double. The :lbname formulation is 

optional an allows you to specify a variable label that describes the content of the new variable.  

 

To generate the new variable we may type  

 

generate x = mpg/weight       (or shorter: gen x=mpg/weight)  

 

If you want to change the content of an existing variable, you can use the replace command:  

replace oldvar = exp [if exp] [in range] [, nopromote ]  

 

 

 

Exercise 3; You can use the help function to establish what the following commands does; (these are must-to-

know STATA commands). Don’t do all that now, but try, as an example, e.g. “list”. A more complete and 

readable description you can find in the PDF-Documentation mentioned above.  

 

save  

correlate  

summarize  

tabulate  

sort  

label  

describe  

list  

count  

mark  

drop  

keep  

regress  

egen  

rename  

merge  

collapse 

test  

predict  

clear  
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7. Num(ber)lists:  
Often you will find reference to numlist in the STATA syntax description. Numlist is simply a 

sequence of numbers, which can be specified in various ways. As an example; the sequence 2 4 6 

8 10 and the numlist 2(2)10 will mean the same in STATA. To get an overview of different ways 

to specify numlists, type help numlist.  

 

 

8. Logical expressions:  
If you decide to use the optional [if exp] specification you must use a special syntax for logical 

expressions.  

== equals to             ( = written twice) 

~= not equal to  

>= larger than or equal to, etc..  

>   larger than  

<   less than  

&   and  

|     or  

 

EXAMPLE (do this)  
tabulate make rep78 if foreign==1  
tabulate make rep78 if foreign==1&price<4000  
tabulate make rep78 if foreign==1|price<4000  

 

How many different makes did you get in each of the three cases?  

 

Note 1: Note (e.g. in browse) that the variable “foreign” has two values, 1 (with label “Foreign”) 

and 0 (with label “Domestic”). The actual values, 1 and 0, are stored, but the labels “Foreign” and 

“Domestic” are displayed in the data base. If you click one value (i.e. one of the “Foreign”s), you 

will see the corresponding numerical value in the small window at the top of the data base 

window. The command, label list, will give a list of labels defined. You can learn how to define 

labels in your data set by help label.  

 

Note 2: In the review window called Commands you find a list of earlier commands you have 

used in the session. If you wish to rerun one of those, just click on the command and it will show 

up in the command window. There it can be easily edited in the usual way if you wish.  

 

Note 3: Another useful feature when writing commands is the variables window which lists all 

variables used in the session. When you need the name of a variable in a command, just click on 

the name in the variable list and the name will show up in the command at the place where the 

cursor is.  

 

 

9. Graphics  
The graphics facility in STATA is quite well developed and allows numerous variations. For a 

start it is recommended to experiment with the graphics menu. You can then note the syntax that 

is automatically written in the results window. Use the auto dataset. Make a histogram of price 

using 10 bins (Command: histogram price, bin(10)). You can also use the menu, Graphics -> 

Histogram. Compare box-plots of foreign and domestic cars (graph box price, medtype(line) 

over(foreign)). Draw a scatter diagram of miles pr. gallon and weight (twoway (scatter mpg 

weight)). Try also to reproduce these three graphs by using the graphics – menu.  
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Note that in help twoway you can learn how to make overlaid graphs (i.e., several graphs put on 

the top of each other), for example you could draw a density function on the top of an histogram 

to assess graphically the goodness of fit of a probability model.  

 

To make a graph of a function, ( )y f x  , use1
 the command twoway function . E.g., make 

a graph of the pdf in the N(3, 4) distribution (i.e. where 3   and 
2 4    ), with pdf  

 

 
 

21
3
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1

( ) for
2 2

x

f x e x


 
     


  

 

A plot of this (do it!) in, e.g., the range (-4, 10) is achieved by ( note that the constant Pi is 

specified as _pi in Stata)  

 
twoway function y=exp(-(x-3)^2/8)/(2*sqrt(2*_pi)), range(-4 10)  

 

 

10. Linear regressions:  
 
To fit simple or multiple linear regressions, use the regress command (or by the menu:  

statistics - > linear regression …. ). Using the auto data, generate the variable x=mpg/weight 

and type:   
regress price mpg weight x foreign  

 

Exercise 4; Interpret the estimated model2
 using your common sense. Check out the syntax for the 

predict command3
 used after the regress command and use it to obtain the predicted price and 

residuals [e.g. predict predy produces a new variable in the database containing the predicted 

values. It is here called predy, or another name that you choose. The command predict res , 

residuals produces a new variable in the database, containing the residuals (i.e. observed price 

minus predicted price), with name res, or another name of your choice.]  

 

Can you use the scatter command, or the graphics->Two way graphics (scatterplot, line etc) 

menu to assess whether the model specification is likely to be heteroscedastic (e.g. plot the 

residuals against the predicted price)? Use the help facility to list the functions library. Generate a 

                                                           
1 You get more information in:  help twoway function 

 
2 In regression analysis we try to explain a dependent variable (price) by a linear combination of some 

explanatory variables (mpg, weight, x, foreign). In other words:  

 
0 1 2 3 4price = mpg weight foreign + errora a a a x a             

where the constants 
0 1 4, , ,a a a , which appear under “Coef” in the output from Stata, are determined 

(estimated) by the program from the data by the “ordinary least squares (OLS) method. The linear combination 

(before the error term) represents the explained part of price and is called predicted price when the 'ja s  are 

estimated. If the model is good, the error term should be evenly distributed around zero (i.e. have constant 

variance) whatever the value of predicted price. If that is not the case, we call the model heteroscedastic. The 

error terms are non-observable (since the 'ja s  are unknown), but can be estimated by the so called residuals = 

price minus the predicted value. 

 
3 See help regress postestimation for info on the command predict and other commands 

relevant for extracting additional information after having run a regression estimation  in STATA. 
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variable that equals the natural logarithm of the price and re-estimate the model. How would you 

interpret the model now?  

 

 

11. Using log-files:  
 
The log facility allows you to print or save all commands you used for a session with STATA. To 

start logging a session, type log using sessionname (or open the log via file.. on the menu), where 

sessionname is the name you decide for the session. This logging you may turn off and on again 

temporarily during the session by the commands log off and log on. When the session is 

completed,however, type; log close. In the results window you will now be told where the log file 

is saved. When you want to view or print the log file you type; view address\sessionname.smcl (or 

use view… on the file menu).  

 

Note. “smcl” is the program STATA uses to produce output files, also called “review files” (see 

help smcl for more information). It produces files with the extension smcl. You can copy content 

in the viewer to a word document in the usual manner (i.e., marking, copy and paste). If you want 

the log-file in the usual text format, you must use the extension log to the name you are giving to 

the log-file you are using, e.g.,  

 

log using “logg1.log”   (where your name is to the file is “logg1” say.)  

 

As a shortcut use the menu, File -> Log -> Begin, to open a new log-file.  

 

 

 

12. Make patterned/random data  
 
Input the following lines and figure out what they do (by checking what happens in the browse 

window). 

Command Notes 

clear To empty STATA of all data and variables before a 

new session. 

browse 

(or click the browse icon) 

To open the browse window.  

Set obs 100  

Check the browse window It should indicate that the data matrix will consist 

of 100 observation units. 

egen year = fill(1900 1901) “egen” is an extended version of “generate” that 

we need for defining new variables, e.g. consisting 

of patterned data and other types. 

egen trend = fill(0.1(0.1)10)  

generate a = sin(trend)  

generate cycle=trend+a  
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twoway (line trend cycle year)  

set seed ? Replace ? by an integer of your choice, e.g. your 

birthday like for example 100781. This starts the 

algorithm for generating random data. By using the 

same seed you can produce the same data later. If 

seed is not specified, stata will choose a seed by 

default which changes every time you draw 

random numbers. 

drawnorm u Draw 100 iid standard normal observations in u. 

generate gdp = cycle+u  

twoway (line trend cycle gdp year)  

 

 

Exercise 5; Load the auto dataset again. Explain why the following sequence of commands can 

be used to draw a random sample of 20 cars:  

 
gen u = uniform()  

sort u  

mark sample in 1/20  

 

(Check the browse (or data window) after each command) 
 

 

 

13. The do-file editor  
 
Often you will need to type a sequence of commands several times. In this case you should use 

the do-file editor (press the short cut icon with a picture of a pad). In the do-file you can write in 

multiple lines and run them in a sequence. You can save the do-file for later use. Often you will 

want to specify loops in the do-file editor. As an example, suppose you have variables with 

names; year1, year2, year3, … , year100, and that you want to transform these variables from 

string to real numbers. You can then type (don’t do this now unless you have 100 string variables 

called year1, year2,… defined in the data base!)  

 
forvalues x = 1/100 {  

generate y`x’ = real(year`x’)  

}  

STATA will then perform this command successively for `x’ running from 1 to 100. Note that all 

the definitions for numlist can be used with this command.  

 

To test out a loop, try the following command in a do-file (for the di command see below).  

 
forvalues x = 2/20 {  

di “I will do `x’ attempts to do my homework properly”  
}  

Note1: This small program you can also enter directly in the command window. Note that the 

three lines must be entered separately: After the first line press enter. Then a number, 2, appears 



11 
 

waiting for the second line and so on. The last line (the end brace) closes the program input and 

runs the program. (Note that the single quotes in `x’are different. The first one I find on my 

keyboard on the top of the back-slash (\) key, and the last one on my *-key.)  

 

Note 2: Sometimes after a session you would like to save the commands you have used for a later 

session. You can do this directly by right-click on the review window for commands and go to 

save… You can also load the commands you have used into the do-file editor: First right-click the 

review-window and select all. Then right-click again on the marked area and go to Send to do-file 

editor. There you can edit the commands – e.g., removing commands you don’t want – and save 

the do-file for later use.  

 

 

14. Calculator  
 
di is short for the display command. display is used for printing strings or scalar numbers. It can 

be used as a calculator. Try out the following (-> denotes output):  

You want the value of e:  

 
di exp(1)  

-> 2.7182818  

 

You want higher precision (10 decimal places):  
di %12.10f exp(1)  

-> 2.7182818285  

 

You want to describe the output:  
di “e = “ exp(1)  

 

You want to calculate 2  ( in STATA is _pi ):  
di sqrt(2*_pi)  

 

 

15. Loading data in ASCII format or from an Excel-file:  
 

 If data is in ASCII format, you cannot use the use command. Try instead the insheet 

command. You can check out the syntax for insheet using the help facility.  

 If you have data organized as columns in an Excel-file, it is easy to get them into Stata. 

(1) If the data set is not to large, you can simply use copy of the Excel-data (mark all 

columns with data including the variable names in the first row) and paste them into the 

edit data window by pointing at one of the columns. (2) If the data set is large, you can 

also use the import function in Stata from the menu: File -> import -> ODBC data 

source  (or directly -> Excel spreadsheet). 

 You can also easily copy data from the Stata data window and paste them into Excel in 

the usual manner.  
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Exercise 64  
 

a. STATA has implemented the cdf of the ( ,1)  -distribution, i.e., the function 

gammap(a,x). [ See help probfun for a list of probability functions implemented, and help function 

for a list of functions in general.]. For example, di gammap(2, 1.5) gives .4421746, which is 

the probability ( 1.5)P T   where T   (i.e., 2  ).  

 

Now, make a table of ( 1 | )P T t T t    for 0.5, 1, 1.5, 2, 2.5, 3, 3.5t         , and for 

0.5, 1, 2 (with 1always).          Note that writing ( )F t  for the cdf of T, we get  

 

    
( 1 ) ( 1)

1 | 1 1 | 1 1
( ) ( )

P T t T t P T t
P T t T t P T t T t

P T t P T t

     
           

 
  

Hence  
 

  
1 ( 1) ( 1) ( )

1 | 1
1 ( ) 1 ( )

F t F t F t
P T t T t

F t F t

   
     

 
  

 

 

 [Hint: First empty STATA of all data by the clear command. Then open the data spreadsheet e.g. 

by the data editor icon. Enter the data for t (0.5, 1, …., 3.5) in the first column. I.e., start 

with writing 0.5. Note that it appears in the little window at the top. Press enter. Now, the 

number is entered in the first cell of column 1 (with name var1). Write the second number, 

1, and press enter and so on. Change the name of the first column from var1 to, for 

example, t, by (in the edit data base) marking the variable name in the upper right window 

and edit the name in the lower right window.  

After thus having entered the numbers for t, generate a new column, named e.g. y1, with 

 1 |P T t T t    for 0.5   . This can be done by the gen command:  

 

gen y1 = (gammap(.5,t+1) – gammap(.5,t))/(1 – gammap(.5,t))  

 
[Note. If you copy this command from this pdf-file and paste it into the command window, the command 

will not work. This is because the two minus-signs are not copied correctly from a pdf file. So: first copy 

and paste the command in the command window. Then remove the two minus-signs and replace them 

with minus-signs from the keyboard. Then the command should work. ]  

 

Repeat this for   equal to 1 and to 2.  

 

Note that you now can save the results in a Stata data set by the save command. Say you 

want to name the dataset “gam”, for example. Then use the command save gam. The table 

is then saved as a Stata data set in your working directory under the name gam.dta. You can 

easily retrieve the data in a later session (using the same working directory; see section 3), 

simply by the command use gam.]  

 

b.  Suppose we want to calculate ( 4)P T   when ( 2, 3.2)T        , with   different 

from 1. In order to use gammap for this we must transform T to ( ,1)  . According to the 

solution of Rice exercise 2:61, ( ,1)Y T   . Hence, for 3.2   we get  

 

                                                           
4 This exercise is about the gamma distribution. If you have not seen this before, you may jump to exercise 7 and 

8, and do exercise 6 later when you have learned about the gamma distribution. 



13 
 

 ( 4) (3.2 (3.2) 4) ( 12.8)P T P T P Y         

 

Then you can use gammap. (Confirm that the answer is 0.9999619).  

 
 

Exercise 7 

a. Stata is good at numerical integration (using the integ command).  Suppose you need the value 

of the integral 

23 3 ( 2)

1 1

( )
xe

f x dx dx
x

 

  , which is a difficult (transcendent) integral. Numerical 

integration consists of dividing the integration interval (( 1, 3) here) into many equally spaced 

points, calculate all the ( )y f x  values, joining the points ( , )x y  by simple functions, and 

calculating the area under the approximate curve. Reproduce the following: 

 

Command Notes 

clear To empty STATA of all data and variables before a 

new session. 

range 1 3 200 Divide the interval (1, 3) into 200 points. (Inspect 

the result in the browse window.) 

gen y =exp(-(x-2)^2)/x Calculate y for each x (inspect the result) 

line y x Plot y against x with lines between the points 

integ y x Calculate the integral 

 

Is ( )f x  a pdf over (1, 3)?      (defining ( ) 0f x   for x outside the interval) 

We may also want the cumulative integral, 

1

( ) ( )    for  1 3

x

F x f u du x    . This is easily obtained 

by adding the option, gen(cy), to the integ command (where I have called the variable with the 

cumulative values for cy).  I.e., do the following 

integ y x,gen(cy)   (and inspect the result) 

Now, line-plot both y and cy against x in the same diagram by 

line y cy x 

 

b. Try out the Stata numerical integral in a case we know the answer : 
3

1 3

1

0.318092....xe dx e e      . Calculate the integral by integ as above and compare 

with the exact result. 
 
c. The function, f(x), in a.  may be turned into a pdf, by dividing the function by the integral-

value. That is most easily done by using that, just after running integ, the result is stored in the 
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constant, r(integral).  (Check that by the command, disp r(integral) , just after having run 

integ.  So, to turn the function into a pdf, run the following command 

 

replace y =y/r(integral) 

  Then check the effect by running integ y x  again.  

 

Exercise 8   
 

One famous approximation in the history of mathematics is Stirling’s formula5 (discovered around 

1730 by Abraham de Moivre and James Stirling) which provides an approximation to factorials: 

(1) 

1

2! 2
n

nn n e


   

where the approximation gets better as n increases. The question is in what sense the approximation 

improves when n gets larger. It actually means that the ratio of the left side of (1) divided by the right 

side tends to 1 as n  (as proven by de Moivre and Sterling). What about the difference, i.e., the 

left side minus the right side?.  

Let us illustrate this by Stata: 

Command Notes 

clear Empty Stata 

set obs 20  

egen n=fill(1 2)  

click the browse icon to see the result  

gen nfac=round(exp(lnfactorial(n)),1) Generates n!. Stata calculates first ln(n!) 

by the function lnfactorial. To get n!, we 

therefore calculate exp(ln(n!). This may 

create some decimal points which are 

removed by the round-function. 

gen nfacappr=sqrt(2*_pi)*n^(n+.5)*exp(-n) Generate the approximate value of n!. 

gen lerror= nfac- nfacappr 

 

Generate the absolute error 

gen frerror= nfac/ nfacappr 

 

Generate the relative error 

format nfac %25.0fc 

 

To change the look of n! in the browse 

window. 

 

                                                           
5 See, e.g., Sydsæther II, exrcise 3 to section 6.3 
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Note that the absolute error seems to increase with n while it is the relative error that seems to 

converge to 1.  

 

It was this approximation that enabled de Moivre to derive the normal distribution 

approximation to binomial probabilities – which seems to be the first known appearance of the 

normal distribution in the history 


